RefWorks II: Creating Your Personal Database

Add references to your RefWorks database through various methods:

O O0OO0OO0OO0O0Oo

downloading via
importing directly from an online database

importing from a saved text file

manually entering information

searching remote databases from within RefWorks
importing data from RSS feeds

grabbing information from webpages with RefGrab-It

find it © STANFORD|

1. Creating your Database: findit© STANFORD)

The find it O STANFORD) button found in many Stanford-licensed databases includes the

Download option to move a selected citation into RefWorks.

1. Obtain a search result in the online database
2. Click on the find it © STANFORD)| button

3. Under the
Download
option, select
RefWorks from
the pulldown
menu, and click
Go.

4. If not already
logged in,
RefWorks will
launch and
prompt you to
log in.

5. Reference will
be automatically
imported into
the Last
Imported
folder

6. In RefWorks,
click on View
Last Imported
Folder to
confirm the
reference loaded
correctly
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2. Creating your Database: Direct Import

A “direct import” feature for RefWorks is available in several Stanford-licensed online
databases. This feature allows a single record or a selection of several records to be
imported into RefWorks with a single button click. Details on importing vary slightly for
each database but the general directions are below.

1. Obtain a search result in the online database

2. Mark records to be imported into RefWorks

3. Select Marked Records, View/Print/Email, Export, RefWorks, or similarly labeled
option to begin copying your selected reference into RefWorks. If you need help, select
the Help link in the online database.

3 http:/ fsearch.lanl.goy - SearchPlus - Search Results - Microsoft Internet Explorer - | m] él
J File Edit Wiew Fawvortes Tools  Help | s |
St ries =L
HHE] SEARCHPLUS s RESEARCH
My account Results for search: (life on mars <in= TilierSubjectd hstrac)
Login / regi In databasels): BIOSIS Engineering index inapec [S1AR& Humanities 151 Social SciSearch 151 SciSearch Hewise this search
ogin / register N
Sorted by: Relevance Save as alertfsearch
Set preferences Limits: (Year == 2007, Year == 2007} Printer friendly

1 out of 855454 records matched your query: 1 displayed
Edit alerts /

saved searches

e e el Interactive scatter plot

Beta version: Long load time. Reguires Java 1.4.2. You can check your version of Java.

Basic search
Mark Al .
Advanced search =>> Unclick to unmark

Cited browse
Marks  Title, Author, Source

Cllgul 5o
¢' S~ [ 077 1 Input output - No life on Mars
3 &rke(l records ’ Thilany, J
— Souree: MECHANICAL ENGIMEERING; JAK 2007;v.128, no.1, p.64-64
Search history

find it O STANFORDI: ) Tovyt s Ful Record

About SearchPlus

4. If not already logged in, RefWorks will launch and prompt you to log in.
5. References will be automatically imported into the Last Imported folder

/3 Refworks Web Based Bibliographic Management Software - Microsoft Internet Explorer i =] 4|

S
RefWO Pks welcome, Stella Ota. Log out

Stanford University

Search RefWDrksI GDl

File Edit Wew Favorites Tools Help

References = | Search~ |‘..l’iewv | Folders~ | Bil]-liogr:||)ll)|r|Toolsv | Help~

Import from OCLC

Back to Reference List

Importing references, please wait...

EEEE T

Import completed - 10 references imported

| View Last Imported Folder |[ view Log |

&l [ [ otemet Z
6. Click on View Last Imported Folder to confirm the references loaded correctly
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3. Creating your Database: Importing a Text File

Most online databases allow references to be saved as a tagged text file. RefWorks can
import the text file via “filters” to translate each database’s field tag into the
corresponding RefWorks field, e.g. “AU” translates to “author”. Each database requires a
separate filter. General directions for importing via filters are below.

1. Obtain a search result in the online database
2. Mark records to be imported into RefWorks
3. Download or save the records as a text (*.txt) file in “tagged” or other appropriate

format. See the database’s Help for the recommended format to use for RefWorks.
4. Log in to RefWorks

5. From any window, under the References menu, choose Import

/3 Refworks Web Based Bibliographic Management Software - Microsoft Internek Expl =10l x|

File Edit Yiew Favorites Tools Help | s ‘

RefWO Pks welcome, Stella Ota, Log out

Stanford University
References~ | Search~ |\|I’iewv | Folders~ | Bihliograph),.r|Toolsv | Help ~ Search RefWorksI Gol
IITIpDI‘t How to Immport | List of Filters & Databases | Request a Filter
Back to Reference List
6 F> Import Filter/Data Source Igtanfgrd University LI
Database | sciSearch [Los Alamos National Library] =]
Import References into Igpecify Falder (Dptional)j
[Mote that references are also put in the Last Imported folder)
& Import Data from the following Text File
9 F> | Browse... |
Encoding IANSI Latin 1 LI Specify only if you specifically set the encading whan

zaving the text file; otherwise leave it as is

" Import Data from the following Text

3

6. For Import Filter/Data Source, select the database company
7. For Database, select the name of the database

8. For Import References into, if you do not want references added to the default Last
Imported folder, select a folder

9. For Import Data from the following Text File, click Browse to select your file

10. Or, copy and paste your text file content into the Import Data from the following
Text box

11. Click Import at the bottom of the window
12. Click on View Last Imported Folder to confirm references loaded correctly.
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3.1 Creating your Database: Importing a Text File from Socrates

Records from Socrates can be imported by using a filter. However, three caveats:
0 Socrates can only format 50 records at a time
o0 Library/Location (e.g. GREEN/Bender Room) information will not import
o Call number imported may not be the correct call number

First, format records for output from Socrates:

1. In Socrates, mark the desired records for output by clicking on the Mark button for the
record.

2. After marking records, click on Email/Print/Save above the search results.

Zj iLink ILINK GATEWAY - Microsoft Internet Explorer o] =]

J Ele Edt Wew Favorites Tools Help JLmks > H @ - s |
EJOURNALS | DATABASES | OTHER CATALOGS | INTERLIBRARY LOAN | MY ACCOUNT | ASK US
1 .
Socrates: Stanford's Online Catalog
Simple Search Comhbined Search Zall Mo. Browse Electronic Resources Course Reserves
GoBack | Help | New Search | ExittHome
Print or email marked records Options for marked records
Remove checked titles sortby: [Tite =
lib H -
I~ The Einstein dossiers : science and politics--Einstein’s e IALL _I
Berlin period with an appendix on Einstein’s FBI file . i ds:
Grundmann, Siegfried, 1938- view of records: |y -I
I~ Secrets of the old one : Einstein, 1905 s s
3 Bernstein, Jeremy, 1929- View fSave/Print 4
[~ Einstein for dummies
Calle, Carlos 1 EMAIL: EMAIL
[~ Einstein : a hundred years of relativity b
Robinson, andrew, 1957 - SUBJECT: I
I~ Einstein on race and racism
Jerome, Fred
[&] pore ] Local intranet: 7

3. Confirm that desired items are included in the list of marked records.
4. Choose View/Save/Print or Email to obtain formatted records.

Then, import records into RefWorks
5. Login to your RefWorks account
6. Under the References menu, choose Import
7. For Import Filter/Data Source, choose “SIRSI Library Software”
8. For the Database pulldown, choose “Stanford University’s Online Catalog (Socrates)”
9. a. Click Browse and select the saved text file
or
b. Paste formatted records from the View/Save/Print or Emailed Socrates display into
the Import Data from the following Text box
or
c. Copy and paste a single record into the Import Data from the following Text box
[Note: any call numbers and URLSs in the record will fail to transfer with this method]
10. Click on Import
11. Confirm that references loaded correctly
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Back to Reference List
3 VYiew fields used by: |AF'A - American Psychological ASS'LI | Save Reference | | Save & Add New |

4. Creating your Database: Entering References Manually

[

. Log in to your RefWorks account

. From any window, under the References menu, choose Add New Reference

3. Optional If you know what output style you might use, select it from the View
required fields for drop-down menu.

4. For In Folder(s), select a desired folder to place the reference. A “?”” will appear next
to the selected folder until the reference is saved.

5. For Ref Type, select the type of reference. The fields will then change to only those

appropriate to that reference type. A green “v"” will appear next to

required/recommended fields if an output style was selected under View required
fields for at the top

N

} Refworks Web Based Bibliographic Management Software - Microsoft Internet Explorer 10| =l

8 |
Refwo Pks wWelcome, Stella Ota. Log out

Stanford University

J File Edit Wiew Favorites Tools  Help |JLinks »

References | Search ~ View v|Folders »|Bibliography Tools ~ Help ~ Search RefWorksI

New Reference vindicates fields used by vour selected output style,

In Folder(s) |specify Folders (if any) x|
Ref Type [1oumal =l

Source Type Iprim vl

Authars v I Separate each author

with ";", See detail
¢ (o [ulle]f]

Periodical, Full v |

Pub Year v I

volumne v |

Issue v |

Start Page v |

Other Pages v I

cronaarges [+ [ U]

Database v |

Retrieved Data v |

Periodical, Abbrey |

Pub Date Free Form |

Descriptors | Separate sach descriptor

with ";", e.g. Diet:
Abstract [p 0, U |42 |[ %,

Health Behavior

6. Enter information for the reference
7. Click Save Reference when done
8. To view the reference, choose View from the top Folders menu and select the folder
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5. Creating your Database: Searching Remote Databases from within Ref\Works

Most public databases, such as library online catalogs, implement a Z39.50 standard
protocol which allows you to use the RefWorks interface to search the remote database
and save references directly into RefWorks. Note: Searches performed through RefWorks
may lack the precision and functionality available through the database’s own interface

1. From RefWorks, under the Search menu, choose Online Catalog or Database
2. Select the remote database to search from the Online Database to Search list

3. Adjust the Max. Number of References to Download

4. For a Quick Search, enter terms and then hit the Search button to the right

5. For a Boolean Advanced Search, enter search terms and hit the Search button at the

bottom of the window

/2 refworks weh Based Bibliographic Management Software - Microsoft Internet Explor

_ 1o

Elle  Edt Wew Favortes Iools  Help

' 8|

RefWorks

Welcome, Stella Ota. Log out

Stanford University

References~ | Search~ |Viewv ‘ Folders~ ‘ Bibliography | Tools v~ | Help ~

E—
Search Refiworks] GDI
—

Search Online Database request s z35.50 site

Online Database to Search:

Back to Reference List

[Pubhed
Max. Number of References to Download: [10 =] 3
Quick Search for: (Quick search rasults are bazed upan the TETIE TupRared by the host site that you have salactad)

Search Clear

RAE

Advanced search for:
[Title, Prirmary =]

and >
[Titie, Primary =]
and >

Title, Primary =

5

[&] Done [ [ [ [ ntermet 7
6. Results appear in a new window.
/A Refworks - Online Database Search Results - Microsoft Internet Explorer I ] Y
Fie Edt Vew Favortes Toos Help [ ] ‘
RefWorks pusvied
Search Results for "obesity overweight costs economics™
Use: @ Selected © page ¢ All in List Sort by | Default I= |
8 Import to Folder... =] (Hote that references are also put in the Last Imparted folder)
T RefID: 1 Journal Reference 1 of 10 View
Title: Socioeconomie issues affecting the treatment of obesity in the new millennium
Authors: Martin L.F.; Robinson, &, Moore B.J.
Source. FPharmacoeconomcs, 2000, 18, 4, 335-353, New Zealand
™ RefID: 2 Journal Reference 2 of 10 View
Title: Putting a price on fat
Authors: Ortolon, K
Source: TexMed., 2004, 100, 4, 45-49, Tnited States
7 ¥ Refio: 3 Journal Referance 3 of 10 iy
Title: Get ready for a life-and-death battle over obesity
Authors: Colwin, G.
Source: Fortune, 2004, 150, 1, &4, TUnited States =l
[&] bone [ @ memet 4

7. Select references to import (click to place checkmark in box)

8. Select folder (optional) and click Import

9. To confirm the reference imported correctly, choose View from the top Folders menu

and select the folder
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6. Creating your Database: Importing Data from RSS Feeds

RefWorks has an integrated RSS Feed Reader. Moving headlines, short descriptions, and
other information in the RSS Feed into RefWorks is a simple one-button click. First the
feed must be added to the RefWorks RSS Feed Reader. Then the RSS news item is easily
imported from the Feed Reader into your database of citations.

First, to add an RSS Feed to RefWorks:
1. Locate the RSS feed you wish to include.

2. Copy the RSS feed’s URL
3. From RefWorks, under the Search menu, choose RSS Feed

/} refworks Web Based Bibliographic Management Software - Microsoft Internet Explorer =0l x|

S
RefWO Pks Welcome, Stella Ota. Log out®

Stanford University

Search RefWorksI

J File Edit Yiew Favorites Tools Help

J Links

References »|Search =|View ~|Folders ~|Bibliography | Tools v Help ~

RSS Feed RSS Feed Instructions

RSS Feed URLI ﬁ E Add RSE Feed | Back to Reference List

|

4. Paste the shortcut into the RSS Feed URL box and click on Add RSS Feed

5. Once added, the RSS Feeds will be listed alphabetically by the feed title, as provided
by the feed itself. The list will display below the Add RSS Feed button. Also included is
the feed’s description, if provided by the feed itself.

3 Refworks Weh Based Bibliographic Management Software - Microsoft Internet Explorer — IDlll
J File Edit Yew Favortes Tools Help | s |
R fW ] Welcome, Stella Ota. Log out

e OP S Stanford University
References v|Search v View v Folders | Bibliography|Tools | Help -
RSS Feed
RSS Feed URLI Add RSS Feed | Back to Reference List
Global Issues Edit Delete
Global Issues Top Stories
Human Rights Edit Delete
-J|> Human Rights Top Stories
U.8. Department of State - Highlights Edit Delete
U.5. Department of State - Press Releases Edit Delete
] [ B[ T T[4 nteme 4
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Then, to add a news item from an RSS feed into your database:

1. From the RefWorks RSS Feed page, click on the name of the feed.
2. A new RefWorks window opens, containing RSS feed “articles”.

3. Checkmark the individual references to move into your citation database. Or move a
selected amount of the references via the radial buttons above the Import button.

/3 RefWorks - Online Database Search Results - Microsoft Internet Explorer =lolx|
J Eile Edit Miew Favorites Tools Help ‘ s ‘
RefWO Pks U.S. Department of State - Press Releases i
RSS Feed
3 \’:> Use: ™ Selected ¢ Page © allin List Sort by |DeFauIt ;I
| Import | |Imp0r‘t to Faolder... ;I [Mote that references are also putin the Last Imported folder)
[ refio: 1 Journal Referance 1 of 10 [ view find it ©STANFORD)
Title: Secretary Rice To Ottawa To Attend Securtty and Prosperity Partnership of North Amenca Meeting
Authors: State, 11,2 Department of
Source: 1.5, Department of State - Press Eeleases, 2007
TUEL: hitp:/fwrwrw. state. cowtpa/prafp s 2007 february/ 80644 htm
3 W ref 1D 2 Journal Reference 2 of 10 D view find it©STANFORD| —
frie- Human Fights Council Sudan Assessment hlission Denied Visas
Authors: State, .3 Department of
Source: 7.3, Department of State - Press Releases, 2007
TEL: htteiferanw. state. sovitpalprs/p s 2007 febriary 80619 tm
[ Refin: 2 Journal Referance 3 of 10 (] wiew find it© STANFORD
Title: Daily Press Briefing -- February 16
Authors: State, 11,2 Department of
Source: 1.5, Department of State - Press Eeleases, 2007
. hitp:fwwwr state. cowtipalpre/dpb /2007780610 htm
3 F’ W refID: 4 Journal Reference 4 of 10 D view find it ©STANFORD
Thtle 1.3, Signs Open Skies Awiation Agreement with Liberia
Authors: State, .3 Department of
Source: 7.3, Department of State - Press Releases, 2007
TEL: htteiferanw. state. sovitpalprs/p s 2007 febriary 80602 htm =]

4. To confirm the reference imported correctly, choose View

3 Refworks Web Based Bibliographic Management Software - Microsoft Internet Explorer - |EI|1|
J File Edit Wiew Favorites Tools Help | s |
R fW ] Welcome, Stella Ota. Log out™
e OP S Stanford University
References »| Search v|View »|Folders v Bibliography Tools = Help ~ Search RefWorksI Go
Last Imported Folder switch to: [Standard view =]
Use: * selected ¢ FPage  allin List Sort by IAuthors, Primary j‘

Add to My List |Put in Folder... =] | Rernove from Folder || Global Edit || Delete |

I RefID: 1 Journal Reference 1 of 2 GLast Imported Wiew
Title: Human Eights Council: Sudan Assessment Mission Dened Visas

Authors: State .5 Departrnent of

Source: 1.5, Department of State - Press Releazes, 2007

T RefID: 2 Journal Reference 2 of 2 GLast Imported Wiew
Title: 113, Signs Open Zkies Awiation Agreement with Libena l/\l

Authors: State 1.5 Departrnent of

Source: 1.5, Department of State - Press Releazes, 2007 4

Edit find it & STANFORD

Edit find it & STANFORD

=
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3 : WEB PAGE INFO OTHER INFO

Last Modified:  2/13/2007 10:34:57 PM Local Timezone (GMT - 7he)
4 ";9

7. Creating your Database: RefGrab-It

RefGrab-1t works with your browser to capture bibliographic information (i.e. URL,
page title, date accessed) about a specific webpage.

To use RefGrab-It:

1. Download and install the program by selecting RefGrab-It from the Tools menu in
your RefWorks account. For Windows-based machines, compatible browsers are
Internet Explorer or Firefox. For Mac systems, Firefox and Netscape browsers may be

used. Once installed, RefGrab-It is available from your browser’s toolbar or
bookmarks.

2. From a webpage of interest, to obtain the bibliographic data on that webpage, click on
RefGrab-It in the browser toolbar or in the bookmark list.

<2} The Stanford Daily Online - Microsoft Internet Explorer B~ 101 x|

Grcery | @ |
Ampmng [
v The Stanford Baly &5

An Independent Publication

N

“ File Edit View Favorites Toals Help |J Links @] Customize Links 4% Free ACL & Unfimited Internet &% ‘Windows Marketplac

o

P

THURSDAY August 30, 2007 I Search | Last update: August 30 02:28 AM PDT =
2| | »
‘@ Done ’_’_’_’@’_ ‘-J Unknown Zone (Mixed) 2

3. A "temporary results page™ opens in a new window. This page shows you:
0 URL to the web page
0 basic information gathered from the web page
o0 supplemental information that RefGrab-it has found related to the
webpage’s content

2} RefGrab-It - Microsoft Internet Explorer =] |

J e i e e———

|tinks (] customize Links A, Free AOL 8 Unlimited Internet 82 Windows Marketplace  (&] RefGrab-It ‘ ] ‘

5 =1
RefWorks

Information found at: The Stanford Daily Online
http: Aédaily . stanford..eduy

RefIDx: 1

Fef Type Web Page

Seurce Type: Electronic

Title: The Stanford Daily Online
Aeccessed, Year 2007

Accessed,
IMonth/Day:
TURL: http/idaily. stanford. eduf

ERetriewved Date:  9/13/2007

Created 2/13/2007 10.34:57 PM Local Timezone (GMT - Fhr)

9132007

-]
& T w4
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4. Click the import button to add this information to your RefWorks account. If you are
not logged in to your account, you will be prompted to log-in. Otherwise, your records
will appear in the Last Imported folder.

/Z http:/ /www.refworks.com - Refworks Web Based Bibliographic Management Software - Microsoft Internet E =10 x|

J File Edit ‘“iew Favorites Tools Help |JLinks >

R fw‘ k Welcome, Stella Ota. Log out
e OP S Stanford University

References ~|Search ~/View v Folders ~|Bibliography | Tools ~|Help ~

Last Imported Folder switch to: [standard view =]

Sort byIAuthors, Primary 'I

Use: ™ Selected ¢ Page  allin List

Add to My List |Put in Folder... ;I | Rermove from Folder || Global Edit || Delete |

I_ Ref ID: 3958 ‘Web Page Reference 1 of 1 DLast Imported wiew Edit find itCJSTANPORD
Title: The Stanford Daly Online

Authors:

Source 2007, 911372007, http/daily. stanford. e du

5. There may be an Other Info tab on your temporary results page. This tab display links
to additional information such as:

0 Books (ISBNs included on the web page you selected)

0 Articles (Additional information found from PMIDs on the web page)

o Digital Objects (Includes information found based upon DOIs on the web
page)

0 RSS Feeds (Lists all feeds on this page--some of which may not relate to
the information you are viewing).

I RefGrab-It - Mozilla Firefox =10l x|
File Edit \iew History Bookmarks Tools  Help

4P etting Started L:,', Physics Library L:,'. fstrononmy_Sstrophy..., L:,', Physics | | RefiErab-Ik

Refwo Pks RefGrab-It

Information found at: The Stanford Daily Online
http: ffdaily .stanford.eduy

WEB PAGE INFO BRugiy]= iyl gi]

RSS Feeds - Lists all feeds on the page (sorme of which may not relate to the information you are wiewing)

6 RES2.0
httpeffdaily . stanford.eduf=mlfrss2

6. Select any of the additional information you wish to view by clicking on the
appropriate link. You will have the option to import any of the other information
RefGrab-It locates. Note: RSS Feeds you wish to keep will need to be copied and added
from within your RefWorks account.

SKO 2007.09.13
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